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Preface
Cinegy Title allows the addition of multiple layers of automation controlled, template based titles, logos, animated graphics,
and more. From simple ticker tapes and lower thirds to multi-layer character animations, Cinegy Title includes a whole range
of advanced effects and features. This module addresses simple requirements such as logo insertion right through to complex
branding with templated information and animated video plates.

With broadcast automation controlled scheduled playout, sequences are often changed or modified right up to the last
minute, or even during playout. With Cinegy Title you can make changes on the fly. Simply turn items off (pure pass thru),
turn parts on/off (e.g. logo), or invoke certain templates, plates or other titles manually independent of the automation
schedule.

Use the Cinegy Title Editor to build complex visual scenes, harnessing the full power of the Cinegy Title engine. Allow users
to alter specified elements in a pre-created template using the simple and intuitive template viewer – letting production staff
easily utilize the work of the graphical design team.

The Cinegy Title template builder and title designer allows you to build creative templates offline with all the effects and
features required to make professional templates quickly and easily.
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Chapter 1. Installation


We do not recommend using Remote Desktop Protocol (RDP) to work with Cinegy Title Editor due to some
protocol limitations related to GPU acceleration.

To start installation, run the Setup.exe file from your Cinegy Title installation package. The setup wizard will be started:

Press "Next" to proceed with installation or "Cancel" to abort and exit the setup wizard.

Read and accept the license agreement:

Chapter 1. Installation
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Next define the installation folder for Cinegy Title to be installed to:

Press "Next" to proceed.

Press the "Install" button in the dialog that appears to begin installation. A progress bar will show the progress of the
installation process.

On the final step, press the "Finish" button to complete the installation and exit the setup wizard.
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Chapter 2. Configuration
To access Cinegy Title application settings, choose the "Settings…" command from the "Edit" main menu; the following
dialog will be opened:

2.1. General Settings
Use this tab to define general settings of Cinegy Title Editor.

Display Options

Enable the "Use selected font in the Text editor" option to apply the selected font for the textbox.

Once this option is selected, a text entered in the textbox is displayed in the "Text" field according to the selected font.
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Once font settings in the "Font" parameters group are changed, these changes are applied immediately to the text in the
textbox.

Cinegy Title 24.11

Page 6 | Document version: 065cfcc



Safe Zones

A safe zone is an area of the television picture where objects placed inside it can be seen on most television screens. Once
the settings for safe zones are chosen, the canvas displays the rectangular area with a red and two grey boxes. The red box
is the margin of the frame, the grey ones are the object safe and title safe areas.
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Live and On-Air Plate Background

It is possible to display static image or animated video preview in the plate object with the "Live" and "On-Air" source while
working in Cinegy Title Editor.

For this, in the corresponding section press the "…" button and choose a graphics or video file that will be displayed during
template preview. Choose the "Animate while editing" option to play the video defined as a live or on-air plate background
during template preview.

Press the "Reset" button to restore the default setting.

Audio

From the "Default audio device" drop-down list choose the device for audio playback.
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Logging

It is possible to define a custom folder where the log files will be stored. In the "Logging" section press the "…" button and
choose the desired folder.

Having configured the required settings, press "OK" to apply the changes.

2.2. Archive Settings
In the "Archive settings" tab you can configure access to the Cinegy Archive database via the Cinegy Archive Service (CAS)
when Cinegy Title is called from Cinegy Desktop.

Enable the Cinegy Archive integration by selecting a corresponding option and define the following parameters:

• Database server – the SQL server name where Cinegy Archive database is stored;

• Database – the Cinegy Archive database name;

• CAS server – the URL of the machine where the Cinegy Archive Service is running;

• URL – this field is filled in automatically when the CAS server is discovered. For this enter "localhost" or specify a
network computer name in the "CAS server" field; then press the "Discover" button for the system to automatically detect
the CAS server URL address.

• Domain – the name of the domain you are using;

• Username – the user name under which connection to Cinegy Archive will be established;
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• Password – the user password.

Having filled in all the fields, press the "Test" button to check the entered settings.If connection to the database
is established, the following message will appear:
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Chapter 3. Getting Started

3.1. Creating a New Title Scene

In order to launch the application, double-click the Cinegy Title Editor icon available on your Windows desktop or
from the Windows start menu.

To create a new scene, select the "New" command from the "File" main menu or use the Ctrl+N shortcut. In the following
dialog that appears, specify the scene name and choose the appropriate video format from the drop-down list:

The Cinegy Title Editor window will be opened:

Now you can start working with your new scene.
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
Cinegy Title Editor provides means for creating templates with variable parts that can be filled in directly
during playout and reused multiple times.

Importing Cinegy Type Templates

The CG templates previously created in the Cinegy Type application can be imported into Cinegy Title. For this use the
"Import…" command from the "File" main menu.

 Cinegy Type is now end-of-life and will be removed in the next major release of Cinegy Air.


The following features are currently not supported and will be ignored during import: per-character text
effects, analog clock, value replacement effect, blur and chamfer effects, "Crop X/Y" parameter for plate
object, numeric clock macros.

Saving as Bundle

The Cinegy Title template can be saved as a bundle, i.e. the full package containing the Cinegy Title template file and all its
related assets will be created.

For this, choose the "Save as bundle…" command from the "File" main menu. The following dialog will be opened:

Here define the folder where the package will be saved to and specify the package name. As a result, the folder containing all
fonts and media materials along with the template file will be created in the specified folder.

It is possible to compress the bundle to the ZIP archive by enabling the "Compress" option. The ZIP file containing all the
materials, fonts and the template itself will be created in the specified package folder. If the "Delete files after compression"
option is selected, the folder with used fonts, materials and the template file will be deleted after the ZIP file creation.


Note that the "Delete files after compression" option is automatically enabled after selecting the "Compress"
option.

3.2. Opening a Title Template
To open a previously created Cinegy Title template, select the "Open" command from the "File" main menu or use the Ctrl
+O shortcut; the "Load Template" dialog box appears:
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In the "Repository" field define the path to the folder containing Cinegy Title templates or use the "…" button to open the
folder selection dialog:

Having selected the folder that contains Cinegy Title templates, their list will be displayed in the "Templates" field. Select a
template to see its preview:
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Expand the "Properties" section to review the detailed information about the selected Cinegy Title template:
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Below the "Preview" window the template playback controls are available.

Alternatively, you can use the "Load file…" button to open the standard dialog for opening files and choose a Cinegy Title
template file.

3.3. Interface Overview
The interface of Cinegy Title Editor consists of several working panels.
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The interface comprises 4 main panels:

• Canvas

• Elements panel

• Parameters panel

• Timeline

Canvas

The work with the scene starts with adding an object.

The simplest object available is "Text". To add this object, select it from the "Insert" main menu or right-click the
name of the scene and select the "Text" object from the "Insert" drop-down list. An instance of this object will
be added to the scene, and will become visible in the canvas area.

As soon as the object is inserted, it becomes visible in the canvas window, where it can be easily positioned, rotated or
scaled.
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In the lower part of the canvas panel you will find buttons for controlling the scenes playback. A quick buttons overview is
given below:

jumps to the beginning of the scene;

starts/stops the scene playback;

jumps to the end of the scene;

jumps to the previous keyframe;

jumps to the next keyframe;

exits loop.

Safe Zones

The canvas displays the rectangular area that represents a frame with a red and two grey boxes. The red box is the margin of
the frame, the grey ones are the object safe and title safe areas. Placing the objects inside these areas ensures that they will
be seen on most television screens.

Chapter 3. Getting Started

Page 17 | Document version: 065cfcc

https://open.cinegy.com/products/title/24.11/user-manual/scene-settings#animation


 Refer to the Safe Zones section for the detailed description on how to set up safe zones parameters.

Zooming and Scrolling

For a closer view of the object on the canvas you can zoom it in/out using the zoom slider in the lower-left corner of
the canvas or using the "Zoom In" or "Zoom Out" buttons. Also, you can scroll the mouse wheel while holding the
Ctrl key pressed to zoom in/out on canvas or use the Ctrl+Gray+ and Ctrl+Gray- shortcuts respectively.

To fit the entire frame into the preview window, press the "Reset Zoom and Scroll" button on the right of the
horizontal canvas scroll bar.

The area being zoomed in or out is centered at the mouse cursor position. The scroll bars can be used to get the desired
portion of the frame into view.

Working Area Viewing

It is possible to define viewing mode for the canvas. The options are solid color background, transparent background and
alpha layer preview. Viewing mode can be switched using the following icons in the bottom right corner of the canvas panel:

When the "Solid background" is selected, the color of the viewing area can be customized by entering the HEX
color code in the "Background color" field or using the color selection dialog.


Please note, the solid background color is used only on the Cinegy Title template editing
stage and is not passed to the output.
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When this mode is selected, the background is changed to a checkered board for better understanding of
objects transparency.

Use this viewing option to preview the alpha (key) value of the objects, to estimate and adjust their
transparency.

Floating

The canvas panel can float as a separate window, for example, to be displayed on the second monitor. For this right-click
anywhere within the canvas panel and choose the "Floating" option.

Elements Panel

This panel comprises the following tabs:

• Layers – displays the objects added to your CG scene. The objects can be organized in the tree view according to your
needs. This tab contains the objects toolbar allowing you to quickly add objects to the scene.

• Variables – contains the list of variables created for the current CG scene.

Parameters Panel

The parameters of the selected object are displayed on the parameters panel, grouped into categories:
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All the tabs are content-dependent; this means that their content depends on the specific type of the currently selected
object.

Timeline

The timeline is used to control the scene objects over time.
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Below the time ruler each object of the scene is represented as a separate track with the possibility to change its starting
time and/or duration, add keyframes to create animated effects.

 Refer to the Understanding the Timeline article for comprehensive explanation of timeline.
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Chapter 4. Scene Settings
When a scene is selected in the tree, the tab on the right of canvas (named the same as the scene) displays the global
parameters for the current scene:

4.1. Animation
The scene has a global loop structure with start and end frame markers specifying its range:

• Play Mode – specifies loop play mode. The default option "Once" is used to play the scene just once. You can also set
loop or ping-pong playback mode for scene by selecting the corresponding option from the drop-down list.

◦ Once – the default option is used to play the scene just once;

◦ Loop – option to loop play according to the loop range;

◦ PingPong – option to play the scene back and forth specified number of times

• Loop Start – specifies the initial frame of the loop.

• Loop End – specifies the final frame of the loop.

The start and end frames of the loop span are shown as yellow bars on the timeline:
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• Loop Count – defines the number of loop repeats. Select the "Infinite" option to play loop infinite number of times.


The "Loop Start", "Loop End" and "Loop Count" options are only available with "Loop" or "Ping-pong"
playback mode selected.

• Loop Scene – specifies whether the whole scene should be played in a loop.

• Leave Loop – manually triggers the scene to leave the loop and play to its end.


Leaving loop is also possible by checking the "Leave Loop Trigger" option in Cinegy CG. For more
details refer to the Working with Templates article in the Cinegy CG Manual.

4.2. Background
The scene background settings are listed below:

• Hide On-Air Video – if this option is set, the video of the playlist item with such a Cinegy Title template applied will be
displayed as black frames when being on air.

• Background Color - specifies the background color of the frame viewing area.


Please note, background color is used only on the Cinegy Title template editing stage and is not passed
to the output.

To select the background color, enter the HEX color code or click the box near this field, the following dialog will be open:
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Here you can define the color components in different color modes which can be selected from the drop-down list:

4.3. Text Substitution
Text substitution allows text to text or file replacement according to predefined list. It could be used for the following tasks:

• automated correction of common misspellings;

• automated replacement of banned words;
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• substitution of character-based elements representing emotion with true image elements (emoji, smiley faces, etc);

• use of an image to delineate long text lines within a stationary or scrolling block;

• application of a small icon to represent weather conditions in line with text;

• use of symbols to help clarify displayed information in stock tickers (arrows) or scoreboard results (flags or shirts);

• displaying headshots of team players or involved parties.

The text substitution lists are XML-based files. An example of such file is:

<Variables>
 <Text NAME=”teh” VALUE=”the”/>
 <File NAME=”UA_FLAG” VALUE=”\\server\ua_flag_image.png”/>
 <File NAME=”:)” VALUE=”.\Smileys\Smile.png”/>
</Variables>

New entries can be added by manual editing of an XML file.

Alternatively, the text replacement lists can be created via Cinegy Title interface. To do this, press the "Select file…" button
on the right of the "Dictionary Path" field:

In the dialog that appears specify the name and location of the text replacement XML file:

An empty XML file will be created. Next, press the "Edit…" button:
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The following "Text Substitution Dictionary" dialog will be opened:

It is possible to create text substitution entries of the text or file type. Press the "Add" button and select the corresponding
type from the drop-down list:

Then fill in the "Original" and "Substitution" fields:
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The [ symbol and ${ symbol combination are reserved for tags and variables processing in the text and cannot be auto-
replaced. All symbols between the [ and ] symbols will not be replaced. All symbols between the ${ and } symbols will not
be replaced.

To remove the entry from the dictionary, select it in the list and press the "Delete" button.

To save changes in the substitution dictionary, press the "Apply" button.

If you have created the substitution list as an XML file, you can add it to the dictionary by pressing the "Append…" button.

An image may be displayed inline within text elements to provide a richer display than text alone can provide. To enable
image substitution, select the "File" type and define the text which will be changed in the "Original" field and the graphics file
in the "Substitution" field. The following example shows the “it-flag” text replaced with the flag icon:


In the substitution dictionary table each row represents a replacement rule, and the rules are applied in the
order they are listed. This means that if multiple rules apply to a particular value, the first rule listed in the
table will be applied first, followed by the second rule, and so on.

To enable text or file substitution, the "Use Substitution" option should be enabled:
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4.4. Audio
• On-Air Volume – defines the volume level of the on-air item using Cinegy Title template in Cinegy Air control application.

• Scene Volume – defines the volume level of the template audio output.

4.5. Rendering
The "Source Alpha" parameter defines the rendering method for media files with alpha channel.

The transparency information within an alpha channel is stored in two different ways in the resulting media file – as straight
or premultiplied. In order for the media file to be correctly interpreted in Cinegy Title, the corresponding rendering method
should be specified:

• Straight – transparency data is stored only in the alpha channel, but not in any of the visible RGB channels.


This mode is used by Cinegy Desktop; so, objects with an alpha channel intended for use in Cinegy
Desktop Timeline should be created in "Straight" mode.


Since the end-of-life Cinegy Type uses straight alpha, the "Straight" mode should be used for Cinegy
Type templates intended for import into Cinegy Title.

• Premultiplied – transparency data is stored in the alpha channel and also in the visible color channels, which are
multiplied with a background color (also known as "matted with color"). Semitransparent areas, like feathered edges, will
have colors that are shifted towards the background color in proportion to their transparency values. The background
color can be selected in the "Source Matted With Color" field. By specifying the correct background color, the color in
semitransparent areas will be correctly interpreted.
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Chapter 5. Scene Objects

5.1. Introduction of Objects
Cinegy Title allows scene creation of different complexity levels based on simple text- and image-based objects that can build
titles and graphic designs according to your needs. Cinegy Title offers the following objects to use in your scenes:

Icon Object Description

Text
Simple text at a fixed position

Marquee
Text sliding from right to left or vice versa

Roll
Text sliding from bottom to top or vice versa

Plate
Graphic images (e.g. pictures, logotypes) and animations or videos

Audio
Audio clips

Clock
Customizable clocks, countdowns, stopwatches

Group
A folder for grouping objects

Subtitles
SRT and STL subtitles

5.2. Working with Objects
Cinegy Title uses a layer-based approach allowing you to add multiple objects and group them according to your needs.
Layers are stacked in a bottom-to-top order, which means that the bottommost element of the tree will appear on top of all
the elements displayed on the canvas.

Adding and Deleting Objects

To add an object to the scene, simply click its icon on the objects toolbar:

You can also use the "Insert" main menu and select the desired object type from the drop-down list:
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Alternatively, right-click the scene name in the tree and select the desired object type from the "Insert" drop-down list:

To delete an object, simply select it in the tree or on the canvas and press the Del button or use the corresponding command
from its context menu.

Inserting Objects

The "Insert clip from file…" and "Insert audio from file…" commands available from the "Insert" main menu provide a quick
way to create objects already linked to a certain video and audio file respectively.

Clip Insertion

Use the "Insert clip from file" command to browse to the video file you want to link to:
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The common file selection dialog appears. Select a desired video file and press the "Open" button. A new "Plate" object linked
to the chosen video file will be created. The object duration will be set automatically according to the video file duration:

Audio Insertion

Use the "Insert audio from file" command to browse to the audio file you want to link to:
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The common file selection dialog appears. Select a desired audio file and press the "Open" button. A new "Audio" object
linked to the chosen audio file will be created. The object duration will be set automatically according to the audio file
duration:

Handling Objects

Renaming an Object

In order to rename an object, double-click it in the tree and enter a new name.

Multiple Objects Selection

Multiple objects can be selected in the objects tree. For this, hold the Ctrl key pressed and select individual objects one by
one via mouse click. To select the range of consecutive objects, click on the first object, hold down the Shift key and click
the last object of the range.
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If multiple objects are selected, the parameters panel is displayed blank.

To remove the selection of multiple objects, click on any object in the tree.

Only the objects selected in the object tree are displayed on the timeline.

 It is possible to move multiple selected object as a group on the canvas.

Objects Copying and Pasting

The context menu of the objects provides standard commands for copy, cut and paste operations:

The copied or cut object(s) is pasted inside the object currently selected in the tree. If the scene folder is currently selected,
the object(s) will be pasted at the end of the tree.

You can also use the standard Ctrl+C, Ctrl+X and Ctrl+V keyboard shortcuts for copy, cut and paste operations.
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Objects Moving

You can organize the objects in the tree according to your needs. To do this, left-click the object(s) and drag the selected
object(s) to the desired position up or down the tree. A tooltip will be displayed indicating where they were dropped:

Objects Grouping

The "Group" object is used to organize scene elements in the tree into groups. Any transformation of the group
affects all the objects inside it. To add the group, right-click the scene name in the tree and select the "Group" object
from the "Insert" menu.

To group the objects that are already created in the tree, select the desired objects and use the "Create Group" command
from the context menu:

A new group object will be created with selected objects moved inside it.

 It is possible to create multiple groups nested in each other.

Objects can also be nested in other objects. This is useful for performing transformations in a bundle for all nested objects at
once, rather than editing them individually:
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In this example the background plate can be moved to any location on the canvas and the marquee will keep the correct
position on top of the plate.


Group objects are displayed in dark grey on timeline. Objects grouped inside each other have start and end
markers on the parent object’s track on the timeline.

Hiding Objects

An object in the tree can be hidden for editing purposes. It will not be shown on the canvas.

To temporarily hide the object, click on the eye icon on the left of the object in the tree:

The hidden object is marked with the dimmed eye icon.

 If the object has nested objects, all of them will become invisible.

To make the object visible again, click on the eye icon once more.

Locking Objects

You can lock an object to prevent its accidental modification. For this, click on the grey open lock icon on the left of the object
in the tree:

The locked object is marked with the white closed lock icon.

 If the object has nested objects, all of them will become locked.

To unlock the object, click on the closed lock icon.
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Missing Objects

A yellow sign marks those objects on the elements panel linking to an unavailable image, video, text, or subtitles file or using
an unavailable font for text.

When you open a Cinegy Title template containing links to unavailable media files or missing fonts, the warning window
appears providing you with details:

 Defining the media file source for the objects is described in the Image-Based Objects article.

The objects linked to missing media files are not rendered on playout. These objects can be selected on the elements panel
and edited.

Transformation

After adding an object to the scene it is displayed on the canvas with a yellow rectangular bounding box. On each corner and
in the middle of each side there are transformation handles. These handles can be directly selected and used to change the
bounding box attributes.

To change the object position on the canvas, click anywhere inside the bounding box and drag the object to the desired
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location.

It is possible to scale the object horizontally, vertically, or in both directions at once.

To scale an object both horizontally and vertically, drag one of the corner handles. To scale the object either horizontally or
vertically, drag a center handle.


For text objects the bounding box is the clipping region, but not the real object size. This means text will be
formatted, scrolled and clipped but not scaled within this area. The real size of the text objects is defined by
the font size only, or the scale of any containing group object.

To rotate an object, click on the handle, situated above the upper horizontal handle, and drag to the desired position. The red
handle is a center of rotation.

Besides transforming objects within the canvas you can set all parameters manually on the "Transformation" parameters
panel.

Here you can define the position, rotation and scale coordinates for the selected object or object group:

Use these buttons for each coordinate or enter the desired value(s) via the keyboard. The transformation values are
equivalent to pixels on the screen (canvas).

Value fields have special icon(s) next to them. Each parameter with a  "diamond" icon can be animated and parameters
with a  "chain" can be linked to a variable.
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General Settings

Each object has the following set of general parameters:

• Start – specifies the frame number at which the object track starts.

• Duration – specifies the object track duration, in frames.

• Visible – ticking this checkbox controls the object visibility.

 Please mind that an invisible object is not shown during playout.

• Color – defines the object fill color. Enter the HEX color code or click the box near this field, the dedicated dialog will be
opened allowing to define the color components in different color modes.

• Opacity – specifies the object opacity. You can define the opacity value by moving the slider from 0 to 100% or entering
the desired value via the keyboard. Changing opacity affects all the objects inside the group objects or nested inside
each other.

• Perspective – enables the object transformation considering the perspective projection.

• Cull Mode – specifies which side of the object is culled: front, back, or none.

• Force Progressive – enables the progressive scan output.

5.3. Text-Based Objects
Text-based objects are static text, marquee and roll. They have common transformation, content and general parameters.

Text

A text object is used for different kinds of text fields in a fixed position. To add this object, select it from the
"Insert" main menu; alternatively select it from the "Insert" drop-down list of the tree context menu.

The text for the object can be specified in the "Text" field:

Cinegy Title 24.11

Page 38 | Document version: 065cfcc



You can add variables to the text by linking a previously created variable. For this type in the $ symbol, the list of all available
variables appears:

Double-click the required variable, it will be added to the text and highlighted:

Chapter 5. Scene Objects

Page 39 | Document version: 065cfcc

https://open.cinegy.com/products/title/24.11/user-manual/variables/creating-and-deleting-variables#creating-a-variable


Highlighted Text Effects


If the text object content, which includes formatting applied by tags or using highlighted text effects
functionality, is changed by the text from the variable without formatting tags, that formatting will be lost
and defined general text attributes will be applied to the new text.

Text formatting can be applied via tags or using the interface elements. In this configuration group, the buttons for applying
bold, italic attributes, changing foreground and background colors, inserting images into text are available if the "Show tags"
option is disabled. Otherwise, it is necessary to enter corresponding tags to change the text formatting.

You can format text inside a text object using the following tags: [b] [/b] for bold, [i] [/i] for italic, [color] [/color]
and [bgcolor] [/bgcolor] for text and background color formatting respectively as it is shown in the example below:

Alternatively, disable the "Show tags" option and use the formatting buttons:

 The text formatting buttons are active if the cursor is placed inside the text in the "Text" field.


The text formatting buttons are inactive if "Right to Left" option is selected. In this mode the text formatting
can be applied only via tags.

Formatting

Cinegy Title 24.11

Page 40 | Document version: 065cfcc

https://open.cinegy.com/products/title/24.11/user-manual/scene-objects/text-based-objects#general-text-attributes


Select the text or place the cursor inside the word and press the "Set Bold" and/or "Set Italic" button(s) to apply the
corresponding formatting. The button with applied formatting will be highlighted in light grey.

Color

To apply the foreground or background text color, press the corresponding button. Pressing the  sign opens the following
drop-down menu:

 The most recently used color is displayed on the "Foreground" and "Background" buttons.

Choose one of the pre-selected or recently used colors or press the "Create Custom Color…" button to define another color,
the "Select color" dialog will be open. Here you can define the color components in different color modes:
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 You can also use predefined basic colors or recently used colors from the corresponding palettes.

For the foreground color, applying the "Reset Color" command changes the text color to the value defined in the "Color" field.
Resetting the background color removes the color highlighting from the text.


If a text color is defined via the "Foreground" button when the "Text" field is empty, the same color is
applied to the "Color" parameter.


If all text is selected in the "Text" field, the color set via the "Foreground" button is also applied to the "Color"
parameter.

Color Picker

The color picker tool allows to select any color on the canvas while working within "Select color" dialog.

To activate the color picker tool, press the "Pick color" button. Move the mouse cursor over to the canvas, the
cursor will change its icon to the eye dropper. To select the color, simply click on the desired spot within canvas:

Cinegy Title 24.11

Page 42 | Document version: 065cfcc



To exit the color picking mode, press either the Esc button, or click the right mouse button, or press the "Pick color" button
one more time.

After pressing "OK" button in the "Select color" dialog, the selected color will be added to the "Recent colors" section.

Image

To add an image inline with text, press the "Insert image" button; the following options are available:

Select the size of the image to be inserted - the size of uppercase, lowercase characters or the full font size (the height of the
string for the defined font size). The "Default font size" option corresponds to the value defined with the "Default Graphics
Size" parameter. Then the common file selection dialog is open.
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Following are the results of the image inline insertion:

General Text Attributes

In the "Font" configuration group you can specify the formatting parameters, such as font family, size, font style (bold and/or
italic).

 Please ensure that the custom set of fonts is installed on both working and playout stations.
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 Start typing the font name in the "Family" field for quicker navigation through the fonts list.

In the "Color" field define the text color.

Text-Related Parameters

The following parameters block allows you to define various text-related parameters:

If the "Use Substitution" option is enabled, the text will be replaced on the canvas according to the predefined replacements
list.

 Refer to the Text Substitution paragraph to set up the text substitution functionality.

Select the "Word Wrap" checkbox to split long text into lines inside the text object box on the canvas without actual line
breaks.

Select the "Right to Left" checkbox to enable the right-to-left languages writing style.

The "Vertical Direction" option enables the vertical orientation of the text in a line.

Select the "Subpixel Align" checkbox to enable the alignment with sub-pixel accuracy.

The "Horizontal Align" and "Vertical Align" parameters define the alignment of the text within the text object boundaries. The
values are represented with the corresponding icons.

The "Default Graphics Size" parameter defines the default insertion mode for all graphic objects inserted into the text. Use
the drop-down list to choose between "Uppercase Font Size" to fit the graphic object to uppercase letter size; "Lowercase
Font Size" to fit to lowercase letter size and "Full Font Size" to fit the height of the string for the defined font size.

Spacing

The "Spacing" configuration group contains parameters for defining spacing behavior between text characters, words and
lines of text within the text object boundaries.

The results of these changes will be visible in real-time within the canvas area.

Marquee / Roll

The marquee object is most commonly used to create news tickers allowing the text to move from right to left
on the screen. To add it to your scene, select it in the "Insert" main menu; alternatively select it from the "Insert"
drop-down list of the tree context menu.
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The roll object is similar to the marquee, except that the text slides from top to bottom or vice versa. To add it
to your scene, select it in the "Insert" main menu; alternatively select it from the "Insert" drop-down list of the
tree context menu.

Specify the text for the marquee / roll object in the "Text" field.

 Refer to previous paragraph to learn more about text formatting.

Animation

Go to the "Animation" section to specify the marquee / roll movement parameters.

Modes of Movement

There are two animation modes for the marquee / roll object – movement by percentage value (progress), and movement by
absolute speed.

Progress

The "Progress" field defines percentage of progression of the text through the complete scrolling animation at any given point.

At the start point the marquee / roll value is 0% which means that no portion of the text is visible on this initial frame. When
you scroll through the timeline, you will notice that the value of this field is increasing before reaching 100% at the final frame.
This means that for the final frame the text scrolling has been completed and its last trailing character has been moved from
view.

No matter how long the text value entered into the object is, the animation will complete within the specified time. However,
this can result in text that moves at a rate that is unsuitable.

There is a dedicated "Progress" track for the marquee / roll object on the timeline. When the "Progress" parameter is
animated, the corresponding keyframes are displayed on the "Progress" track.
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Speed

The "Speed" value specifies the speed of the characters movement in pixels per frame.

If the "Use Speed" option is selected, the characters move with the speed defined in the "Speed" field, and the "Progress"
parameter is ignored. This is a great way to be sure that text will move at a readable rate, although consideration of the
overall display duration must now be given.

Play Mode

It is possible to make text scrolling follow a loop or ping-pong playback path. To do this, select corresponding playback mode
(Loop or Ping Pong) from the "Play Mode" drop-down list and specify the number of repetitions in the "Loop Count" field. To
play the marquee / roll just one time, set the "Play Mode" to play once. These operations only have an effect when working
with "Speed" mode of movement.

Free Run

"Free Run" feature relates to the global loop. Let us consider its effect by an example.

Suppose you have a very long text for the marquee object. In order not to make a very long duration for the object, you can
use the following trick: create a global loop at the end of the object duration and set it to loop infinite number of times.

As a result, the marquee text will play until the beginning of the loop, and if the "Free Run" option is enabled, the text will
continue to slide continuously until stopped manually. If this option is not enabled, the text will constantly jump back to the
position of the first loop frame, or in ping-pong mode run backwards.

Leave Loop on End

This option is useful when used together with "Free Run" feature.

When you use the previously described trick, with the "Leave loop on end" option enabled the marquee will leave the loop
automatically as soon as its text ends and play until its end.

Image Insertion

An image can be inserted into a text object of any type: static text, marquee, roll. This can be done in several ways.

Insert Command

In the "Text" field place the cursor to the location where you would like to put the image and choose the "Insert" > "Image…"
context menu command:
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The dialog box appears allowing you to select a desired graphic file. Once it is selected, press "Open" to insert an image to
the text:

 The size of the image being inserted depends on the "Default Graphics Size" parameter settings.

The inserted image can be removed or changed using the corresponding command from the menu invoked when the mouse
cursor is placed right before or after the image and the right mouse button is pressed. This menu also provides options to
define the inserted image size when displayed on the canvas - the size of uppercase, lowercase characters or the full font size
(the height of the string for the defined font size). The "Default font size" option corresponds to the value defined in the
"Default Graphics Size" parameter.
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Using a Tag

Another way to insert an image to the text is using a tag referencing to the graphic file. Once you type in the [ symbol via a
keyboard, you will be prompted to choose fitting mode for the image being inserted:

Or simply use a keyboard to enter a tag with a reference to the graphic file in the following way:

[img c:\picture.png] - to fit the inserted image to the "Default Graphics Size" parameter settings;

[imgfull c:\picture.png] - to fit the inserted image to full font size;

[imgup c:\picture.png] - to fit the inserted image to uppercase letter size;

[imglow c:\picture.png] - to fit the inserted image to lowercase letter size.

Using a Variable

You can add a graphic file to the text by linking a variable of the "File" type. Once the variable with an image file is created,
you can place it directly to the text via the "Insert" > "${Variable_name}" drop-down menu command:
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Alternatively, use a keyboard to insert variable to the text. Once you type in the $ symbol, the list of available variables
appears allowing you to choose the required one:

 The size of the image being inserted depends on the "Default Graphics Size" parameter settings.

5.4. Image-Based Objects
An image-based object is a plate. It can be used to create a visual design of your Cinegy Title scene.

Plate

The plate object allows you to add a media source to your scene, such as pictures or video files. To add this
object, select it from the "Insert" main menu; alternatively select it from the "Insert" drop-down list of the tree
context menu.

It has the following parameters:
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Source

In the "Source" drop-down list choose the media source type: file, on-air or live.

File

Press the "…" button to select the media source file on your local disk or a network location:

Alternatively, enter the path manually via the keyboard.

You can also link a plate object with the variable of the "File" type referring to the media file or variable of the "String" type
containing the path to the media file. To do this, click the  sign next to the "File" field and select the "Create new…"
command to create a new variable of choose a previously created variable from the list below:
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Recommended image formats are png, tga, bmp, jpg, tiff; video formats – avi, mpg, mp4, mxf, mov.


Animation display in animated image formats is not supported. If the animated gif image is chosen for the
plate object, only the first frame will be displayed.


A relative path can be specified to define a media file location. For example, if the Cinegy Title template is
saved in the "D:\CG" folder (it is called the root folder) and the media file path is "D:\CG\media\logo.png",
the relative path will be ".\media\logo.png".


In the case when the logo is small and is going to be displayed in the corner of the screen, it is
recommended to use an image/video file of a small frame size. Use of the full frame sized image/video with
a large transparent area will lead to unnecessary computation load.

On-Air

The Cinegy Title application supports displaying the live video content as a background of the image-based object. To enable
this feature, select the "On-Air" source:


By default, during the template preview this object will be displayed as color bars. You can change this in
the Live and On-Air Plate Background settings.

Live Feed

It is possible to link plate objects to live video input supported by the Cinegy Playout engine. To do this, select the "Live"
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source:

In the "Live ID" field define the source ID, configured in the Cinegy Playout configurator.


Refer to the Cinegy Title Inputs section in the Cinegy Playout Manual for more information on source
setup.


By default, during the template preview this object will be displayed as color bars. You can change this in
the Live and On-Air Plate Background settings.

Key&Fill Mode

The plate object can be set up to work in Key&Fill input mode.

The following scheme explains the Key&Fill mode principle inside Cinegy Title template:

For this select the "Enable" option and define the "Key ID" which corresponds to the instance number of the "Key" signal
defined in the Cinegy Playout configurator.
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Fill  Mode

You can specify fill mode for the object, selecting one of the following modes:

• Fill – stretches the image or video so that it fills the bounding box entirely.

• Preserve Aspect – scales the image or video so that it fits in the bounding box, preserving the original aspect ratio.

• Preserve Aspect Anamorphic – scales the image or video so that it retains the original aspect ratio of the asset, except
the original aspect is corrected to the 16:9 format.

• Unscale – applies no scaling to the image or video.

• Unscale Anamorphic – the image or video remains of the exact original size in pixels, except a single scaling factor is
applied to correct the aspect to 16:9.

• Tile – the image or video of the original size will create a seamless pattern to fill the plate object area.

Animation

The following additional settings are available for a video file:

• Play Mode – set video file playback mode. The default option is used to play the video just once. You can also set the
loop or ping pong play for video by selecting the corresponding options from the drop-down list.

• Loop Count – specify the number of repetitions or select the "Infinite" option to play continuously.

• Free Run – this option allows the video to play continuously until its end irrespective of the timeline progression –
always advancing one frame forward each time the scene moves in any direction or position, in the same manner as the
marquee and roll objects.

• Run – this option is available for plates containing video files and is active if the "Free Run" option is active. When this
option is enabled, the video in the plate object is played during the template playback.

• Freeze on end – check this option to display the last frame of the video after the end of its playback. If this option is not
set, the video will turn to transparent after its playback ends.
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• Action on end – with free-run mode selected, you can define the behavior at the end of clip used in the plate. Choose
one of the following:

◦ None - continues running template in the normal way;

◦ Leave any loop – leaves the loop when reaches it’s end;

◦ Immediately leave any loop – immediate jumps to the end of the loop and then leaves it.

Audio

A video file containing audio can be assigned to the plate object. The following settings are available in the "Audio" section:

• Enable – the option for switching audio on/off inside the plate object.

• Volume – specifies the audio volume level.

Multichannel audio is supported in plate objects. The corresponding number of audio channels should be specified in the
Cinegy Playout configurator in the "Audio" tab for a successful playback of the template with multichannel audio in plate
object.


If RTP/UDP/SRT output is used, the corresponding number of audio channels should be configured in
RTP/UDP/SRT output audio settings.

Corner Radius

It is possible create rounded rectangle plate objects. For this use the "Corners" group of settings:

Define the corner radius values in the "Radius" field or specify them in the separate fields for each corner.

When the "Synchronize Corners Radius" option is active, the corner radius value will be the same for all corners. To specify
different radius values for each corner, deselect this option and enter the radius values in their dedicated fields. In this case it
is possible to create keyframes and add variable links for each corner separately.

If for each corner separate keyframes and/or variables were created and after that the "Synchronize Corner Radius" option is
enabled, the corresponding warning will notify that all keyframes and/or variables will be deleted except the top-left corner
ones. Pressing "OK" in the following warning will accept the deletion, while pressing "Cancel" will cancel the corners
synchronization.
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5.5. Audio Objects
The "Audio" object is not displayed on the canvas. The audio will be mixed into the stereo pair and integrated to the audio
output on the rendering engine.

It has the following parameters:

Define the audio file by pressing the "…" button.

By default, the audio object is enabled. To disable it, deselect the "Enable" option.

The audio volume can be adjusted in the "Volume" numeric box or by using the slider.

It is possible to make audio play in loop or in ping-pong mode. To do this, select corresponding playback mode (Loop or Ping
Pong) from the "Play Mode" drop-down list and specify the number of repetitions in the "Loop Count" field. To play audio just
one time, set the "Play Mode" to play once.

The "Free Run" feature description is given here.

5.6. Clock Objects
The "Clock" object allows you to set up the generated clock display on your scene.

It has the following parameters:
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• Run – when enabled, the clock will be running.

• Type – specifies the clock type: time, date, stopwatch, countdown, countdown to time or date.

 Depending on the chosen clock type, some of the following parameters can become unavailable.

• Use text as – specifies the position of the text added to the time display. Choose "Prefix" or "Postfix" to place the text
either before or after the time display correspondingly; choose "None" to hide the text and leave only generated clock
display. If the "Custom" option is selected, the text with numeric clock macros syntax applied will be processed to
display different forms of date and time.

• 12-hour clock – enables the time display in the 12-hour time format.

• Time Format – specifies the time format for the clock.

• Date Format – specifies the date format.

• Date Separator – defines the separator character used as the divider between month, day, and year of displayed date.

• Action on end – defines an action on the end of countdown, countdown to time or countdown to date. Choose "None" to
play back the template to the end after the countdown reaches zero. With the "Leave any loop" option selected, when the
countdown reaches zero, the loop is played to the end and then left. If the "Immediately leave any loop" option is
selected, when the countdown reaches zero, the loop is immediately left.

• Start Value – specifies the reference point for the countdown clock and stopwatch.

• Time offset – specifies the time offset value compared with the current PC time.

• Countdown to – defines the time to count down to. For "Countdown to Date" clock types the date field is activated.
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5.7. Subtitles
The "Subtitles" object is dedicated for adding the subtitles to your scene. To add this object, select it from the "Insert" main
menu; alternatively, select it from the "Insert" drop-down list of the tree context menu.

When added, the subtitles object takes up the whole area of the scene:

You can adjust the area of subtitles displaying by changing the position and size of the "Subtitles" object.

The "Subtitles" object has the following parameters:

Define the file containing subtitles by pressing the "…" button.

With the "On-Air" option selected, the subtitles fragment appearance will be calculated based on the timecode of the item
currently being on air. When subtitles timing has no reference to the original item timecode, the "On-Air" option should be
disabled. Thus, the "Time offset" field will become active for the subtitles displaying delay to be specified, if necessary.

 Both horizontal and vertical alignment of the text is supported during rendering of STL files.
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5.8. Object Layouts
Cinegy Title supports simultaneous broadcast of CG scenes with several layouts configured separately according to your
broadcasting needs. You can add multiple layouts to the current scene from the list of available layouts depending on the
original CG scene TV format.

Video Format PAL NTSC

Standard Definition
720x576 4:3 25 fps
720x576 16:9 25 fps

720x480 4:3 29.97 fps
720x480 16:9 29.97 fps

High Definition

1280x720p 25 fps
1920x1080i 25 fps
1920x1080p 25 fps
1280x720p 50 fps
1920x1080p 50 fps

1280x720p 29.97 fps
1920x1080i 29.97 fps
1920x1080p 29.97 fps
1280x720p 59.94 fps
1920x1080p 59.94 fps

Ultra High Definition 4K
3840x2160p 25 fps
3840x2160p 50 fps

3840x2160p 29.97 fps
3840x2160p 59.94 fps

Ultra High Definition 8K
7680x4320p 25 fps
7680x4320p 50 fps

7680x4320p 29.97 fps
7680x4320p 59.94 fps

Layouts Managing

To add a new layout, go to the "Layouts" main menu and choose the desired layout format from the "Add" drop-down list:

Or press the  button in the top right corner of the canvas panel:

Chapter 5. Scene Objects

Page 59 | Document version: 065cfcc



A new layout will be added, become active, and ready for further setup.

 Refer to the Working with Objects article to learn about Cinegy Title objects and their setup.

To switch between the existing layouts, go to "Layouts" → "Select" and choose the desired one from the list:

Or simply go to its respective tab:
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To delete the layout, press the  button in the corresponding tab.

The confirmation dialog box appears:

Press "OK" to delete the current layout or "Cancel" to cancel the operation.

 The set of variables is common for all layouts.

When the CG scene with multiple layouts is sent to playout, each layout will be displayed according to its preconfigured TV
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format.

Converting Layouts

The created layout can be automatically converted to the layout of another format. For this choose the target format from the
"Layouts" → "Convert to" drop-down list:

A new layout will be added to the template as a separate tab. The placement of the objects will be preserved and adjusted to
the new format.

It is possible to have only one layout of each format within the template. The formats that are already used in the template
are marked with a  sign in the "Convert to" drop-down list.


If you try to convert a layout to the format that already exists within this template, you will receive a
warning message that content will be overwritten.

5.9. XML Editor
The Cinegy Title templates are basically XML files that are saved with the *.cintitle extension. There is a built-in XML editor
for viewing and editing templates in XML directly.

To open the XML editor, use the "Show XML Editor" command from the "Edit" main menu.
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The following window will be opened:

Here you can change the parameters of the objects. The changes are applied by pressing the "Apply" button and the template
is re-rendered on the canvas automatically. To undo the changes made in the XML editor, use the "Revert" button. You will be
prompted that the changes made in the XML editor will be lost:

The changes will also be reverted on the canvas.

If the template parameters are changed on the canvas, timeline, or the parameters panel, these changes are dynamically
displayed in the open XML editor window.
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

The following special characters get escaped in XML:
" → &quot;
' → &apos;
< → \<
> → \>
& → \&
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Chapter 6. Animation

6.1. Understanding the Timeline
The timeline is used to control the scene objects over time.

The top-right part of the timeline shows the current editing range of the objects display.

Below the time ruler each object of the scene is represented as a separate track with the possibility to change its starting
time and/or duration, add keyframes to create animated effects.

Timeline Panels

The timeline consists of four main panels:

On top there is the ruler that allows you to browse through the frames.

The left center panel displays the object currently selected in the tree. The details displayed in this area change as the
selection changes. It is possible to define the detail level for the scene objects to be displayed on the timeline. If the "Show all
parameters" option from the "Edit" main menu is selected, all parameters of the selected object will be displayed. If this
option is deselected, only animated parameters (that have any keyframes defined) of the object are displayed. To display all
objects added to the CG scene on the timeline, enable the "Show all objects" option from the "Edit" main menu. If this option
is not selected, only the object selected in the tree and its nested objects will be displayed in the objects panel of the
timeline.

In the center panel, you can see objects (or their parameters) as layers in a classic timeline form, where it is possible to
interact with and alter their start time and/or duration.
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The time scale control is located on the bottommost panel. It allows you to change the time scale on the timeline and scroll to
its desired position. Also, you can scroll the mouse wheel while holding the Ctrl key pressed to zoom in/out on timeline.
Alternatively, use the Ctrl+Gray+ or Ctrl+Gray- shortcuts respectively.

Moving the Current Frame Position

There are several ways to move to the desired frame position:

• Click on the desired location on the timeline to jump to that location.

• Left-click the animation position slider and holding it move the slider to the desired timeline location.

• Hit Space to start/stop playing.

• Use the Ctrl+→ or Ctrl+← shortcuts to jump the animation position slider to the next or previous keyframe
respectively.

There is the "Snap to objects" option for the timeline slider. While moving the slider to the desired timeline location, it will
snap to the nearest keyframe or the start/end of the object track. This option can be selected in the "Edit" main menu.

Working with the Objects on the Timeline

Changing the Duration

To change the object track duration, place the mouse cursor over the start or the end of the track. The cursor will change its
icon accordingly:

Press the left mouse button and drag it to the desired position. The track duration will change accordingly.

Repositioning

You can also change the temporal position of the object by dragging it to the desired position on the timeline. To do this, click
on the object track and drag it to the required position. The cursor icon changes to the double sided arrow while dragging.

Grouping

For every object that has  keyframe(s) set up, the corresponding track for every animated property is displayed on the
timeline.

Also, a separate track is displayed for every effect added to an object.
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The objects can be organized using  the group object in the "Layers" tab. On the timeline group objects are displayed in dark
grey. Objects grouped inside each other have start and end markers on the parent object’s track on the timeline.


The duration of the group object on the timeline sets bounds to displaying of all the objects enclosed in that
group. The enclosed objects can have longer duration than the group object duration. In this case the
portion of the objects after the end of the group object track will not be displayed on the canvas.

Group track displays all the keyframes of its nested objects. The topmost track on the timeline displays all the keyframes set
up on all the tracks of the scene:

6.2. Animation Channels

Animation Channels

Animation is the result of changing the object properties over time. For example, you can animate the "Position" property of
the object to make it move from one position to another.

Each property is represented as a separate animation channel. Channels are shown in the tree view for their respective
object.
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Gray diamonds indicate keyframes.

Object properties are animated with the help of keyframes. A keyframe is a frame in which the change of the object property
is defined. The property values between two keyframes are interpolated, i.e. automatically calculated to be distributed along
this span. By default, this distribution is an even span.

When the first keyframe is created for some property, the animation channel for this property becomes active on the timeline.
To create a simple animation, at least two keyframes are needed – one for the initial property value, and another one for the
new value. For more elaborated animations you can add extra keyframes between the start and end keyframes.

Creating an Animation Channel

To create a new animation channel, follow these steps:

1. Find the property you want to animate. In our example, it will be the opacity value.

2. On the timeline select the initial frame for the property to start changing.

3. Specify the initial property value and press the diamond icon on the right of the property:

The diamond icon will become light-gray, symbolizing that a keyframe for this property now exists at the current frame
location.

4. On the timeline move to the final frame of the property changing.

5. Specify the final property value and create a keyframe for it by pressing the diamond once again.

Now you can preview the resulting animation using the "Play" button or scrolling the current frame in the timeline.

Working with Animation Channels

Keyframe Types

There are several types of keyframes and each of them has its corresponding icon:
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Keyframe - the icon for a simple keyframe with no special animation applied.

Ease in - the icon for a keyframe that contains ease in animation.

Ease out - the icon for a keyframe that contains ease out animation.

Ease in and out - the icon for a keyframe that contains both ease in and ease out animation.

 Keyframes easing is described in detail later in this article.

User defined keyframe - the icon for a keyframe with user defined easing.

Loaded keyframe - the icon indicates whether there are multiple types of special animations below this keyframe. In the
example below in the "Position" group for X coordinate the ease in animation is set up, for Y coordinate – ease out is set up,
for Z coordinate – ease in and out is set up. The keyframe for the "Position" group is a loaded keyframe:

Adding and Removing Keyframes

You can add as many keyframes between the start and end keyframes as you need. Specify the time position on the time
ruler and set the parameter to the desired value; the keyframe will be created automatically. Alternatively, press the 
diamond button to create a keyframe and then enter a new parameter value.

It is possible to add a keyframe for compound parameters such as position, rotation, size, scale. Thus, the keyframes will be
created for all sub-parameters, e.g. X,Y,Z for position.

To remove a keyframe, place the time slider on the frame with this keyframe and press the light-gray diamond button near the
respective parameter. Alternatively, you can select the respective keyframe on the timeline and press the Delete button.
Another way to delete the keyframe is to right-click the light-gray diamond and select the "Remove" command from its
context menu:
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Selecting Keyframes

To select a keyframe, click on it. The color of the selected keyframe is changed to blue:

The group track on the timeline displays the keyframes of all underlying objects within this group. When a keyframe is
selected on the group track, the corresponding keyframes on underlying objects are also selected:

The topmost track on the timeline displays all the keyframes set up on all underlaying tracks and groups of tracks.

Repositioning

When hovered over, a keyframe is highlighted with vertical white bar. The mouse cursor pointer is changed to double-sided
arrow allowing you to click it and to drag the keyframe to the desired position on the timeline.

Cinegy Title 24.11

Page 70 | Document version: 065cfcc



Easing

By default, the values between keyframes are interpolated and the value changes in a constant rate for each frame. To create
a more realistic moving pattern, easing can be used. Easing instructs the rendering engine to change the parameter values by
an amount that varies over time, allowing changes to accelerate or decelerate in a realistic manner.

To set the easing type, right-click the corresponding keyframe and choose the required one from the "Easing" drop-down
menu:

The corresponding type of the keyframe will be displayed on the timeline:

There are four types of easing: ease in, ease out, ease in/out, and user defined easing. "Ease in" will make the animation ‘ease
into’ the motion, resulting in an effect that appears to accelerate smoothly rather than leap directly into motion. "Ease out"
provides a way to invert this behavior, where the animation gradually slows until it is no longer changing. "Ease in and out"
combines the effect of both easing types and can be used for intermediate keyframes.

If several parameters of the same or different objects have keyframes at the same position, the "Ease In"/"Ease Out" can be
edited for the group of keyframes on the upper level (object level, group level, scene level).

User Defined Easing

The easing function (the way in which parameter changes over time) can be defined by modifying the Bezier curve. For this
choose the "User defined" easing type. The yellow handle will appear near the keyframe:

Hover the mouse cursor over the handle so that it changes to the four headed arrow:
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Then drag the handle until you receive the desired easing curve:

Deleting the Animation Channel

To delete a specified animation channel, right-click it and choose the "Remove keyframes" command from the context menu:
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Chapter 7. Effects

7.1. Working with Effects
Cinegy Title allows you to modify the appearance of objects by adding different effects to them.

Adding an Effect

When an object is selected in the tree, the toolbar with effects available for this object is displayed, allowing you to quickly
apply or disable the desired effect:

Place the cursor over the icon to see the tooltip prompting you the effect name.

Click the corresponding icon to apply the effect. Once the effect is applied, its icon becomes highlighted. To disable the effect,
click the corresponding highlighted icon once more.

Another way to add an effect to the object is to right-click the object in the tree and from the "Effects" drop-down menu
select the desired effect to be applied:

The tab with the effect settings will be added to the parameters panel.


Each effect can be applied to an object only once. The effects are applied in the defined order in which they
are displayed in the "Effects" drop-down list.
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Effect Parameters

After enabling the effect, its parameters will be displayed in a separate tab on the parameters panel:

Removing the Effect

To remove the effect, simply deselect it in the "Effects" drop-down menu.

7.2. Text Effects
The following effects are available for text objects:

• Shadow

• Outline

• Glow

• Text Auto Fit

• Mask

They are static effects affecting each character of the text.

Shadow

This effect adds a shadow behind the characters:

The shadow effect has the following parameters:
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• Color – specifies the color of the shadow. You can specify the hexadecimal value of the desired color or click the box
with the color rectangle. The dedicated color selection window will be opened allowing you to define the color
components in different color modes.

• Blur – specifies the range of the shadow diffusion (0..10).

• Enlarge – specifies the size of the shadow (0..10).

• Direction – determines the angle at which the shadow will fall. You can enter the value manually or use the slider on the
right.

• Distance – specifies the distance between the characters and their shadow.

Outline

This effect adds a border around each character of the text.

The outline effect has the following parameters:

• Color – specifies the color of the border. You can specify the hexadecimal value of the desired color or click the box with
the color rectangle. The dedicated color selection window will be opened allowing you to define the color components in
different color modes.
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• Width – specifies the size of the border (0..10).

Glow

This effect adds a glow that emanates from the outside of each character of the text.

The glow effect has the following parameters:

• Additive – enables additive blending mode.

• Color – specifies the color of the glow. You can specify the hexadecimal value of the desired color or click the box with
the color rectangle. The dedicated color selection window will be open allowing you to define the color components in
different color modes.

• Blur – specifies the range of the glow diffusion (0..10).

• Enlarge – specifies the size of the glow (0..10).

Text Auto Fit

This effect adds the ability to change the size and spacing of the text if the yellow object frame is big enough. To expand the
frame borders, drag its handles to the desired position.
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The text sizing effect has the following parameters:

• Priority – define the parameter of higher priority – either text size or spacing – choosing the corresponding option from
the drop-down list.

• Dimensions – define what will be affected by the text sizing effect – width and height, width only, or height only –
choosing the corresponding option from the drop-down list.

• Min. Size – determines minimum size to which the text can be scaled down.

• Preferred Size – determines maximum size to which the text can be scaled up.

• Min. Spacing – determines minimum spacing value for the text components.

◦ Char - determines minimum spacing between characters in the words.

◦ Word - determines minimum spacing between words in the text.

◦ Line - determines minimum spacing between lines of the text.
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• Preferred Spacing – determines maximum spacing value for the text components.

◦ Char - determines maximum spacing between characters in the words.

◦ Word - determines maximum spacing between words in the text.

◦ Line - determines maximum spacing between lines of the text.

7.3. Effects for Graphics
The following effects are available for graphic objects:

• Mask

• Gradient

• Text Auto Size

Mask

This effect can be applied to a plate or a text object contained in a group to allow partial or total occlusion of other objects in
this group. Objects can be occluded within the body of the scene by a mask – allowing items to appear on screen from any
position, or to remove sections from an object.


The objects in the tree, that are placed below the object with the applied "Mask" effect, become the
compound mask for this object.

With the "Mask" effect applied, the luminance value of the object acting as a mask defines the appearance of all other
underlying objects: a white pixel of the mask makes the target pixel completely visible, a black pixel of the mask makes a
target pixel transparent.

The mask effect has the following parameters:

Select the "Invert" option to use the reversed mask.

For example, a group contains an image and a white color plate object with 80% opacity.
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The following picture illustrates both variants of applying the mask effect:

All the objects outside the group remain visible regardless of whether they are in the background or foreground respectively
to the group.

Gradient

This effect adds a gradient to plate objects. The gradient can be applied for color and/or opacity of the object.

The gradient effect has the following parameters:
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• Mode – determines the pattern in which the gradient fills the image.

• Edge Mode – specifies how the color will be applied to the areas not covered by the gradient if "Begin Point" is greater
than 0% and "End Point" is less than 100%.

• Direction – determines the gradient transition direction.

• Begin Point – determines the point in percent from the edge of the plate object, starting from which the gradient is
applied.

• End Point – determines the point in percent from the edge of the plate object, at which the gradient will end.

• Begin Color – determines the color for the start of the gradient.

• End Color – determines the color for the end of the gradient.

Text Auto Size

This effect automatically adjusts the size of the plate object to fit the linked text.

 For this effect to work, the text object should be nested inside the plate object.

Cinegy Title 24.11

Page 80 | Document version: 065cfcc



The auto-size effect has the following parameters:

• Left – offset value on the left side of the plate object.

• Right – offset value on the right side of the plate object.

• Top – offset value on the top of the plate object.

• Bottom – offset value on the bottom of the plate object.
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Chapter 8. Variables

8.1. Creating and Deleting Variables
Cinegy Title scenes can be used as templates which can be triggered by the Cinegy Air automation. Declared variable parts
of the templates can be updated either manually or automatically.

Cinegy Title Editor offers the possibility to use variables. They are used for changing the parameters values in one place on a
separate tab rather than having to change them in different places. These variables can also be exported to be directly edited
in Cinegy Air from the control panel before playout.

Creating a Variable

Some parameters controls have a sign near them. It means that this parameter can be linked with a variable. Press this
icon for the drop-down menu to appear:

Select the "Create new…" command to create a new variable for this parameter. The icon will change to  symbolizing that
this parameter is linked with the variable. It will also be added to the list of the variables in the "Variables" tab:

It is also possible to create a new variable directly in the "Variables" tab. Press the "New" button and specify the type of the
variable from the drop-down list that appears:
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Depending on the selected variable type, specify its value. You can also change the default variable name by double-clicking
its default name.

To rename the variable, double-click the default name and enter a new one:

A new variable will have the sign near its name signifying that it is not linked to any parameter. You can link it with the
parameter of the corresponding type. To do this, press the  icon next to this parameter and select the variable from the
"Link" context menu:
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
Many items can link to one variable. For example, two distinct text objects can be set to the same name
parameter, or have their color controlled from a single color variable.

String Variables

If a variable of the "String" type contains long text, just one line with the beginning of the text will be displayed along with the
"…" button that opens the extended text window:

In this window the variable text can be edited:
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 Refer to the Highlighted Text Effects section for detailed description of text formatting and using tags.

 Tick off the "Word Wrap" option to split long text into lines without actual line breaks within the text area.

The variables of the "String" type can contain various metadata references, such as the item and program name, their
scheduled times, comments, descriptions, etc. To include this information in the variable text, type in the $ symbol and select
a corresponding macro from the drop-down list:

Linking a Variable to File

It is possible to link any parameter to the variable of the "File" type. The variable value is read from the file and applied for the
parameter. If the file is updated or overwritten, the variable value is automatically updated. One file can be linked to several
different parameters of the corresponding type.


Be sure to link the parameter to the file of corresponding type otherwise you will receive the error
message.

For this, create the variable of "File" type on the "Variables" tab and define the file by pressing the "…" button. Then choose
the parameter which will take the value from the defined file and link it with a newly created variable.
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Unlinking a Variable

To unlink the defined parameter from the variable, press the  button near it and choose the "Unlink" command from the
drop-down menu:

Deleting a Variable

To delete a specified variable, press the "Remove" button:

If this variable is linked with the parameter, the following dialog box will appear asking you to confirm your decision:
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If this variable is deleted, the linked parameters will become unlinked, and the values will be set to the last variable value.

8.2. Updating Variables
The variable parts of the templates can be updated directly in other Cinegy applications.

When updated, the variable value can take effect according to the update type specified in the Cinegy Title application:

You can set the variable update mode by choosing one of the following options:

• Instant – the value will change immediately.

• Restart – the value will change after the scene restart (i.e. the scene is played again starting from the first frame).

• Autorestart – the value will change after the scene restart, and the act of updating the parameter will automatically
trigger the scene to leave the loop and play to its end.

If the variable is set to be updated after restart or autorestart, its applied values can be set up to wait in a queue until they are
displayed. To enable this feature, select the "Queue" option for the corresponding variable(s). If this option is not set, only the
last applied value will be displayed overwriting the values that have been applied before and are not yet updated.

Dynamic Update

It is possible to change the variable value (or variables list) in the Cinegy Title template dynamically for the items already on-
air by sending an HTTP request to the Cinegy Playout engine. This feature is implemented via the third-party dynamic data
control application.

The following diagram shows the common variable altering process graphically:
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The third-party application sends an HTTP request (POST) to the Cinegy Playout engine, where the Cinegy Title template is
activated, using the XML file as the "request body". This XML file contains the Name/Value pairs for each variable needed to
be updated.


Refer to the corresponding technical documentation for your third-party dynamic data control application
description.

 For a simpler procedure of the variables dynamic update you can use the Cinegy CG application.

8.3. Macros
Macros are used to retrieve metadata from programs and playlist items in Cinegy Air to be substituted for the Cinegy Title
text objects values.

This can be very useful for scenarios like "Coming next" or "Now playing".

Syntax

General Macro Syntax

The general macro code syntax is as follows:

${<source>.<data>}

where:

<source> – specifies the container/item type to retrieve the specified metadata from. Playlist items and programs are
currently supported.

<data> – specifies the metadata field to retrieve the data from. The following fields are supported: name, description,
comment (for items), and start time.

For example:
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${program.name}

The item or program start time macro is available in several variants:

${source.time} – show hours and minutes (the same macro as .time.hm).

${source.time.h} – show hours only.

${source.time.hm} – show hours and minutes.

${source.time.hms} – show hours, minutes, and seconds.

The "time" macro can have the optional postfix for 5-minute rounding:

${source.time.round} – the minutes value is rounded upward or downward (whatever value is closer).

${source.time.ceil} – the minutes value is rounded upward.

${source.time.floor} – the minutes value is rounded downward.

The same postfixes will work for 5-second rounding, e.g. .time.hms.round, .time.hms.ceil, .time.hms.floor.

It is possible to specify the relative number of the container/item, from which the data should be retrieved, in the following
format:

<source+n>

 Here n is any positive number. For items, this value can only equal 1.

Specifying the <source> parameter is not obligatory. When it is not specified, the data will be retrieved from the item.

For example:

${description}

In this case, the macro will return the item description.

Custom Metadata in Macros

Custom metadata fields are also supported. For example, to retrieve the value of the "Notes" custom field for the specified
item, the syntax should be as follows:

${item.Notes}


Refer to the Custom Metadata paragraph in the Cinegy Air Manual for more details on working with
custom metadata fields.

Chapter 8. Variables

Page 89 | Document version: 065cfcc

https://open.cinegy.com/products/air/24.11/air/user-manual/handling-items/managing-items#custom-metadata


Countdown Macros

The countdown macro links the start time of a countdown timer to a specific playlist item.

For example, to show the countdown to the next program in the playlist, the macro syntax is as follows:

${program+1.countdown}

Also, the countdown to the specified date and time is available, its macro syntax is as follows:

${date(year.month.day hours:minutes:seconds).countdown}

The step-by-step description of how to apply the countdown macros is given below.

Numeric Clock Macros

Cinegy Title provides a number of macros for customizing the clocks and countdowns display.

The following table contains information on macros that can be used for the "Stopwatch", "Countdown", "Countdown To
Time", and "Countdown To Date" clock types:

Macro Description

{$yy} Full number of years in the current value.

{$dd} Full number of days in the current value.

{$d} Truncated number of days (from 0 to 30).

{$0d} Truncated number of days with a preceding zero (from 00 to 30).

{$MM} Full number of months in the current value.

{$M} Truncated number of months (from 0 to 11).

{$0M} Truncated number of months with a preceding zero (from 00 to 11).

{$hh} Full number of hours in the current value.

{$h} Truncated number of hours (from 0 to 23).

{$0h} Truncated number of hours with a preceding zero (from 00 to 23).

{$mm} Full number of minutes in the current value.

{$m} Truncated number of minutes (from 0 to 59).

{$0m} Truncated number of minutes with a preceding zero (from 00 to 59).

{$ss} Full number of seconds in the current value.

{$s} Truncated number of seconds (from 0 to 59).

{$0s} Truncated number of seconds with a preceding zero (from 00 to 59).

For example: "{$dd} days are left until the Olympic Games" will be translated to "823 days are left until the Olympic Games".

"{$hh} hours {$m} minutes {$s} seconds are left until the New Year!" will be translated to "285 hours 47 minutes 25
seconds are left until the New Year!".

"Time used by Team A: {$ss} seconds" will be translated to "Time used by Team A: 183 seconds".

The following table contains information on macros that can be used for the "Time" and "Date" clock types:
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Macro Description

{$h}
Current hours value without a preceding zero (from 0 to 23 or 1-12 AM/PM, depending on
the settings).

{$hh}
Current hours value with a preceding zero (from 00 to 23 or 01-12 AM/PM, depending on the
settings).

{$m} Current minutes value without a preceding zero (from 0 to 59).

{$mm}
Current minutes value with a preceding zero (from 00 to 59).

{$s} Current seconds value without a preceding zero (from 0 to 59).

{$ss} Current seconds value with a preceding zero (from 00 to 59).

{$d} Current day as a number with no preceding zero (1 to 31).

{$dd} Current day as a number with a preceding zero (01 to 31).

{$ddd}
Abbreviated localized day name (e.g. 'Mon' to 'Sun'). The system locale is used for name
localization.

{$dddd}
Long localized day name (e.g. 'Monday' to 'Sunday'). The system locale is used for name
localization.

{$M} Current month as a number with no preceding zero (1-12).

{$MM} Current month as a number with a leading zero (01-12).

{$MMM}
Abbreviated localized month name (e.g. 'Jan' to 'Dec'). The system locale is used for name
localization.

{$MMMM}
Long localized month name (e.g. 'January' to 'December'). The system locale is used for
name localization.

{$yy} Current year as a two digit number (00-99).

{$yyyy} Current year as a four digit number.

For example: "Today is: {$dddd} {$dd}.{$MM}.{$yyyy}" will be translated to "Today is: Wednesday 20.07.2022".

Additional macros for time:

{$AP} or {$A} - displays either "AM" or "PM";

{$ap} or {$a} - displays either "am" or "pm".


Please use only "{$h ap}" instead of "{$h} {$ap}" if the system locale is set to display hours in the 24-
hour format; otherwise, it will lead to incorrect display for hours starting from 13, e.g. "15 pm".

Combination of the {$h}:{$m}:{$s} macros can be simplified to {$h:m:s}; both variants will lead to the same time format
display, for example: "15:34:26". {$h:m:s AP} will lead to "3:34:26 PM".

Various combinations are also supported, for example:

{$hh:m:s}{$ap}, {$hh:mm:s}{$ap}, {$hh:mm:ss}{$ap}, {$h:mm:s}{$ap},{$h:mm:ss}{$ap}, {$h:m:ss}{$ap},
{$h:m}{$ap}, {$h:mm}{$ap}, {$hh:mm}{$ap}, etc.

Or {$hh:m:s ap}, {$hh:mm:s ap}, {$hh:mm:ss ap}, {$h:mm:s ap}, {$h:mm:ss ap}, {$h:m:ss ap}, {$h:m ap}, {$h:mm
ap}, {$hh:mm ap}, etc.
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 AM/PM abbreviations could be used in both upper case and lower case form.

 There could be a space symbol between brackets or between time and AM/PM abbreviations.

The step-by-step description of how to apply date/time macros in custom clocks is given below.

Applying General Macros

Macro code is entered in the text value of the text object in the Cinegy Title template.

To add a macro, follow the steps:

1. Add a text object and in the "Text" field enter the macro code according to the general macro syntax described above.

2. Link this text to a new variable:
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3. Edit the Cinegy Title scene according to your needs and save it.

4. Select the desired item in the Cinegy Air playlist, and use the secondary events panel context menu to assign a Cinegy
Title scene display on the specified layer:

5. In the "CG Browser" dialog box that appears, select your Cinegy Title scene in the "Repository" field. The macro code in
the "Template parameters" table will be changed to the corresponding field data value:
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Applying Countdown Macros

Follow the steps to create the Cinegy Title template with the countdown to the specified playlist item and enable its display
in the Cinegy Air playlist:

1. Add a clock object to the Cinegy Title scene:

2. In the "Variables" tab create a new string variable and enter the macro code according to the countdown macro syntax
described above:
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3. In the "Clock" object parameters tab, choose the "Countdown" clock type:

4. Link the "Start Value" parameter with the previously created string variable:

5. Edit the Cinegy Title scene according to your needs and save it.
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6. Select the desired item in the Cinegy Air playlist and use the secondary events panel context menu to assign a Cinegy
Title template display on the specified layer.

7. In the "CG Browser" dialog box that appears, select your Cinegy Title scene in the "Repository" field. You can play the
Cinegy Title template in the "Preview" screen and see how the countdown works.

Numeric Clock Customization

Follow the steps to set up a customized numeric clock display:

1. Add the clock object to the Cinegy Title scene:

2. In the "Clock" object parameters tab, choose the corresponding countdown type from the "Type" drop-down list:

3. In the "Use Text as" drop-down list choose "Custom":

4. Configure the stopwatch or countdown time and/or date according to its type. In this example, specify the date and time
to count down to in the "Countdown to" field:
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5. In the "Text" parameters tab of the clock object, enter the desired text with/or macro code according to the numeric clock
macro syntax described above:

6. Edit the Cinegy Title scene according to your needs and save it.

7. Select the desired item in the Cinegy Air playlist, and use the secondary events panel context menu to assign a Cinegy
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Title template display on the specified layer.

8. In the "CG Browser" dialog box that appears, select your Cinegy Title scene in the "Repository" field. You can play the
Cinegy Title template in the "Preview" screen and see how the countdown works.
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